DiskGenius®

User Guide

The information in this document is subject to change without notice. This document is not warranted to be error free.
# CONTENTS

**Introduction** .......................................................................................................................... 6

**Partition Management** ........................................................................................................ 6
  Create New Partition .................................................................................................................. 6
  Active Partition (Mark Partition as Active) ............................................................................. 10
  Delete Partition ......................................................................................................................... 12
  Format Partition ......................................................................................................................... 14
  Hide Partition ............................................................................................................................. 15
  Modify Partition Parameters ...................................................................................................... 17
  Resize Partition .......................................................................................................................... 20
  Split Partition .............................................................................................................................. 23
  Extend Partition .......................................................................................................................... 26
  Add Free Space to Partition ....................................................................................................... 29
  Assign Drive Letter .................................................................................................................... 32
  Partition Backup ........................................................................................................................ 34
  Restore Partition from Image File ............................................................................................. 40
  Explorer Partition Image File .................................................................................................... 42
  Clone Partition (Copy Partition) ............................................................................................... 46
  File Recovery ............................................................................................................................. 51
  Save Scan Progress ..................................................................................................................... 57
  Recover Files By Type ............................................................................................................... 62
  Load Current Partition Intelligently ........................................................................................... 65
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlock BitLocker</td>
<td>66</td>
</tr>
<tr>
<td>Set Volume Name</td>
<td>68</td>
</tr>
<tr>
<td>Convert Partition Type Between Primary and Logical</td>
<td>70</td>
</tr>
<tr>
<td>Erase Sectors</td>
<td>72</td>
</tr>
<tr>
<td>Erase Free Space</td>
<td>75</td>
</tr>
<tr>
<td>4KB Partition Alignment Detection</td>
<td>78</td>
</tr>
<tr>
<td>Disk Operation</td>
<td>79</td>
</tr>
<tr>
<td>Partition Recovery</td>
<td>79</td>
</tr>
<tr>
<td>Rebuild MBR</td>
<td>85</td>
</tr>
<tr>
<td>Clone Disk</td>
<td>86</td>
</tr>
<tr>
<td>Backup and Restore Partition Table</td>
<td>92</td>
</tr>
<tr>
<td>Create Bootable USB Disk</td>
<td>95</td>
</tr>
<tr>
<td>System Migration</td>
<td>101</td>
</tr>
<tr>
<td>Check and Repair Bad Sectors</td>
<td>108</td>
</tr>
<tr>
<td>View S.M.A.R.T. Information</td>
<td>112</td>
</tr>
<tr>
<td>Quick Partition</td>
<td>114</td>
</tr>
<tr>
<td>Delete All Partitions</td>
<td>117</td>
</tr>
<tr>
<td>Copy Sectors</td>
<td>119</td>
</tr>
<tr>
<td>Clear Reserved Sectors</td>
<td>130</td>
</tr>
<tr>
<td>Convert Partition Table Style</td>
<td>132</td>
</tr>
<tr>
<td>Check and Correct Partition Table Error</td>
<td>135</td>
</tr>
<tr>
<td>Appoint Disk Geometry</td>
<td>137</td>
</tr>
</tbody>
</table>
Batch Format USB Disk.......................... 139
Convert Dynamic Disk to Basic Disk..................... 142
Safely Eject Disk .................................. 143
Set UEFI BIOS Boot Entries.......................... 145
Virtualize System into VMware Virtual Machine........ 146
Virtualize System into VirtualBox Virtual Machine .... 155
TRIM Optimization................................ 160
Operate Windows Storage Pool and Storage Space ....... 164
Virtual Disk and Image Files.......................... 171
Create VMware Virtual Disk File...................... 171
Create Virtual PC Virtual Disk File ................... 172
Create VirtualBox Virtual Disk File.................... 174
Create Parallels Desktop Virtual Disk File ............. 176
Create ".img" Image File............................ 178
Virtual Disk File and Its Partitions.................... 181
Convert Virtual Disk Format.......................... 183
Construct Virtual RAID............................... 185
Disk Sector Editor.................................. 189
Summary.......................................... 189
Sector Editor Common Functions....................... 192
Shortcut Menu.................................... 201
File Operation..................................... 209
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Files</td>
<td>209</td>
</tr>
<tr>
<td>Copy Files From Partition</td>
<td>212</td>
</tr>
<tr>
<td>Write Files To Partition</td>
<td>213</td>
</tr>
<tr>
<td>Delete Files Directly</td>
<td>215</td>
</tr>
<tr>
<td>Delete Files Permanently</td>
<td>217</td>
</tr>
<tr>
<td>Create Folder</td>
<td>219</td>
</tr>
<tr>
<td>Preview Files</td>
<td>220</td>
</tr>
<tr>
<td>Others</td>
<td>222</td>
</tr>
<tr>
<td>Create WinPE Bootable USB Drive of DiskGenius</td>
<td>222</td>
</tr>
<tr>
<td>Reboot to DiskGenius WinPE Version</td>
<td>225</td>
</tr>
<tr>
<td>Reboot and Run DiskGenius DOS Version</td>
<td>226</td>
</tr>
<tr>
<td>Register DiskGenius</td>
<td>228</td>
</tr>
<tr>
<td>Technical Support</td>
<td>236</td>
</tr>
</tbody>
</table>
Introduction

About DiskGenius

DiskGenius is a versatile program packed with comprehensive functions for partition recovery, file recovery, disk management, data backup, disk utilities, etc. It manages storage space with high efficiency, recovers data lost due to disk corruption, formatting, deletion, virus attack, etc. and provides the easiest yet reliable backup solutions to let users say NO to data loss.

Technical Specification

Recommended Hardware requirement: 1 GHz x86 or compatible CPU, 512mb RAM memory, mouse and keyboard

Supported file system: FAT12, FAT16, FAT32, exFAT, NTFS, EXT2, EXT3, EXT4


Partition Management

Create New Partition

You should decide partition type before creating new partition table. There are three types of partitions on an MBR disk, i.e. primary partition, extended partition and logical partition. Primary partition is created on hard drive
directly, which is generally used to install and boot operating system. Due to the limitation on MBR partition table, there can be 4 primary partitions at most, or 3 primary partitions and 1 extended partition. Extended partition is a kind of special primary partition, and it can contain several logical partitions. Logical partition is created on extended partition, and the number of logical partitions is not limited. A GPT disk does not have such limitations.

1. Create new partition on free disk space

**Step 1.** Select free disk space on hard drive and click **New Partition** button from toolbar and Create New Partition window will pop up.
Step 2. Select partition type, file system and partition size and click OK button.

To make sure the partition is 4K aligned you can select option "Align to Integral Multiple of Sectors".

Note: You can click Advanced button to set more parameters for the partition, as follows:

![Create New Partition dialog box](image)

You can set partition's beginning and ending cylinder, beginning sectors and sector numbers. As to GUID partition table, more partition settings are available.

Step 3. Click Save All button to save the partition to current partition table and format the partition.

The newly created partition is not saved to hard drive immediately, as it is created in memory for the moment. Thus, you need to save the partition to current partition table manually before you can see it in Windows Explorer. Such approach is to prevent data loss caused by improper operation.
2. Create new partition on existing partition

DiskGenius is able to create a partition on existing partition by splitting one partition into two without data loss.

**Step 1.** Right-click on a partition and select **Create New Partition** from context menu.

**Step 2.** Enter partition size for these two partitions and click **Start** button.
Active Partition (Mark Partition as Active)

An active partition is a primary partition on an MBR disk and set as the bootable partition that contains the operating system. Only one partition on each hard drive can be set as an active partition.

**Step 1.** To activate a partition, please right-click on the primary partition and select "Mark Partition As Active" from the context menu.
Step 2. Click **Save All** button to make the change into effect.

If you want to remove Active mark for the partition, you can right-click on it and select "**Remove Partition's Active Mark**", as follows:
Delete Partition

It's easy to delete a partition from hard drive, removable disk or virtual disk with the help of DiskGenius.

**Step 1** Select the partition you want to delete and click **Delete** button from toolbar or right-click it to select "**Delete Current Partition**".
Step 2  Click Yes button when DiskGenius asks confirmation.

Step 3  Click Save All button from toolbar to make the deletion take effect.
Format Partition

A newly created partition should be formatted before it can be used to store data. Currently, DiskGenius supports formatting partition to NTFS, FAT32, FAT16, exFAT, EXT2, EXT3 and EXT4 file system.

**Step 1.** Select the partition you want to format and click **Format** button from toolbar, or right-click on the partition to choose **Format Current Partition**.

**Step 2.** Select file system, cluster size, volume label and click **Format** button.

Also, you can select "Surface Scan" which will scan the drive for bad sectors during formatting. However, surface scan takes long time and there is no need to do so on most new hard drives.
As to NTFS partition, you can select Enable Compression to enable NTFS file system's data compression feature.

If the partition to be formatted is primary partition and file system is set as FAT32, FAT16 or FAT12, the option "Create DOS system" will be available. If it is selected, the formatting process will create a DOS system in this partition, which can be used to boot computer.

**Step 3.** Click **Yes** when DiskGenius asks confirmation for the operation, and the partition will be formatted quickly.

![Confirmation Dialogue](image)

**Hide Partition**

**Hide partition**

A hidden partition does not have a drive letter and it cannot be seen in Windows Explorer, thus operating systems cannot access it. Files in hidden partition are not lost, but they cannot be accessed in normal method.

**Step 1.** Right-click on the partition you want to hide and select **"Hide/Unhide Current Partition"** option from context menu.
Step 2. Click **OK** and the partition will be hidden.

Though the hidden partition cannot be seen in Windows Explorer, you can use DiskGenius to access it.

Step 3. Click **Save All** button to save changes to partition table.
Unhide partition

**Step 1.** Right-click on the hidden partition and select "Hide/Unhide Current Partition" option from context menu.

**Step 2.** Click **OK** button when you see following message box.

![Message box](image)

**Step 3.** Click **Save All** button to save changes to partition table. Then the partition will be assigned a drive letter automatically by operating system and you can see it in Windows Explorer again.

Modify Partition Parameters

You can change detailed parameters of a partition with this feature.

**Step 1.** Select the partition you want to modify its parameters and click **Partition** menu to choose **Modify Partition Parameters**.
Step 2. Set partition parameters such as system identifier, beginning cylinder, ending sector, etc. based on your needs and click OK.
**Note:**

1. Changing system identifier does not change partition type or file system type.

2. Partition size changed by this feature may damage data in partition. Incorrect settings may lead to corrupted partition.
Resize Partition

DiskGenius is able to change the size of partition without data loss, and you can use it to extend, shrink or split partition as you like.

**Step 1.** Right-click on the partition you want to resize and click **Resize Partition** as follows:

![Resize Partition window](image)

**Step 2.** Now the Resize Partition window pops up and you can set partition size here. Click **Start** button after setting partition size.

Place mouse pointer on the edge of partition and you can drag it to change partition size; also, you can enter exact number in the column below. The
disk space resized from the partition can be merged to other partitions, kept unallocated or created new partition.

Step 3. DiskGenius prompts operations to be done in following message box. Click Yes to continue.
Step 4. Click **Complete** button when the program finishes resizing partition.

**Note:**

- If the partition resizing process involves operating system, DiskGenius will prompts to enter DiskGenius WinPE edition to complete the task. If your computer cannot boot to DiskGenius WinPE edition directly, you can create a bootable USB disk to boot computer.
- Please do not access the partition being resized in case of any unexpected issues.
- The resizing process may take long time if there are too many files on the partition. In that case, you can set operations after resizing finishes.
- Partition resizing may fail to complete or even cause data loss due to hard drive or partition errors, bad sectors, sudden power failure or system
errors. Thus, resizing partition is a risky action to some extent and data backup is necessary.

**Split Partition**

DiskGenius is able to split one partition into two partitions without affecting data on the drive.

**Step 1**  Right-click on the partition you want to split and select **Split Partition**, as follows:

![Split Partition Step 1](image)

**Step 2**  Set partition size by dragging borders or entering exacting number and click **Start** button.
**Step 3.** DiskGenius prompts operations to be done and things should be noted in the following message box. Click **Yes** to continue.

**Step 4.** Wait for the process to finish, after which click **Complete**.
Note:

- If the partition resizing process involves operating system, DiskGenius will prompts to enter DiskGenius WinPE edition to complete the task. If your computer cannot boot to DiskGenius WinPE edition directly, you can create a bootable USB disk to boot computer.
- Please do not access the partition being resized in case of any unexpected issues.
- The resizing process may take long time if there are too many files on the partition. In that case, you can set operations after resizing finishes.
- Partition resizing may fail to complete or even cause data loss due to hard drive or partition errors, bad sectors, sudden power failure or system errors. Thus, resizing partition is a risky action to some extent and data backup is necessary.
Extend Partition

This guide will show you how to extend partition without data loss, which can be used to enlarge any partition and fix low disk space issue in Windows.

**Step 1.** Right-click on the partition you want to extend and select **Extend Partition** option.

**Step 2.** Select a partition that contains large amount of free space and click **OK**.
**Step 3.** Set partition size you want to move between these two partitions and click **Start**.

**Step 4.** DiskGenius lists operations to be executed and things you should be aware. Click **Yes** to continue.
Step 5. Click **Complete** button when the partition is extended successfully.

**Note:**
If the partition resizing process involves operating system, DiskGenius will prompts to enter DiskGenius WinPE edition to complete the task. If your computer cannot boot to DiskGenius WinPE edition directly, you can create a bootable USB disk to boot computer.

Please do not access the partition being resized in case of any unexpected issues.

The resizing process may take long time if there are too many files on the partition. In that case, you can set operations after resizing finishes.

Partition resizing may fail to complete or even cause data loss due to hard drive or partition errors, bad sectors, sudden power failure or system errors. Thus, resizing partition is a risky action to some extent and data backup is necessary.

**Add Free Space to Partition**

DiskGenius can help you add unallocated or free disk space to any existing partition without losing data. Unallocated disk space can be added to partition no matter whether it is adjacent to the free space.

**Step 1.** Locate and right-click on free disk space and select Allocate Free Space To option. Then you can choose the partition to which you want to add the free space.
Step 2  DiskGenius shows operations to be done and things you should note.

Click Yes and it starts to move disk space to specified partition.
Step 3. Wait for the process to complete and click **Complete** when the process is done.

**Note:**

- If the partition resizing process involves operating system, DiskGenius will prompts to enter DiskGenius WinPE edition to complete the task. If your computer cannot boot to DiskGenius WinPE edition directly, you can create a bootable USB disk to boot computer.
- Please do not access the partition being resized in case of any unexpected issues.
- The resizing process may take long time if there are too many files on the partition. In that case, you can set operations after resizing finishes.
- Partition resizing may fail to complete or even cause data loss due to hard drive or partition errors, bad sectors, sudden power failure or system...
errors. Thus, resizing partition is a risky action to some extent and data backup is necessary.

**Assign Drive Letter**

Drive letter can be assigned, changed, or removed easily with the help of free partition manager.

**Assign or change drive letter**

1. Select the partition you want to assign or change drive letter and click **Assign New Drive Letter** from **Partition** menu.
Step 2: Select a drive letter for the partition and click OK.

Remove drive letter

Step 1: Select the partition you want to delete drive letter and click Partition -> Remove Drive Letter.
Step 2. Click Yes and the drive letter will be deleted.

Note: If drive letter is removed or deleted, the partition will be invisible to Windows.

Partition Backup

Partition backup is able to back up all data and settings of a partition into a specified file which is usually called image file. With the backup file, you can restore partition when the partition gets damaged, or data gets lost.

DiskGenius provides three ways to backup partition.

**Sector-by-sector Backup:** It allows you to create an image of all sectors on the selected partition, including sectors with data and blank sectors. Therefore, the process may take longer time than normal partition backup. The image file can be restored to source partition or other partition which has the exact same size.

**Backup partition by data storage structure:** Back up valid data of the source partition by file system structure to the image file without any change. Since this mode only backs up valid data and it is the fastest. However, when you restore data from image file, the destination partition should have the same size as the source partition.
Backup partition by file: Backs up all files and other valid data of source to image file, which does not backup invalid data and takes shorter time. The image file can be restored to any partition whose capacity is able store these files. Files restored from image file will be reorganized and there won't be file fragments.

The backup file can be compressed, and you can set compression level from Fast, Normal and High Quality. In general, image file with higher compression level is in smaller size but takes longer time. In most cases, Fast is the default and best choice.

DiskGenius supports hot backup when backing up system related partitions, which is able to back up system when Windows is running without rebooting to WinPE or DOS environment.

Backup type: Full backup and incremental backup.

Full backup: Backs up all data no matter whether there is a backup.

Incremental backup: Only backs up changed data or content.

Step 1. Click Backup Partition button from toolbar or click Tools -> Clone Partition To Image File to open backup window.
Step 2. Click **Source Partition** button to select the partition you want to back up and click **Select Image File** button to name the image file and set a location to save it.
You can click **Settings** button to configure advanced settings for the backup, such as select backup mode, compression level, exclude undesired files, etc.
Step 3. Click **Start** button and you can see following message box.

If you choose **Hot Backup** button, and DiskGenius starts to back up system partition directly without rebooting system; if you click **Reboot to WinPE** button, current system will automatically reboot to DiskGenius WinPE edition and continue backup.
Step 4: Want for the backup to complete and click **Complete** when partition is backed up successfully.
**Restore Partition from Image File**

When partition gets damaged, corrupted or files in the partition gets lost, you can try restoring partition from the backup image file to rescue data.

**Step 1.** Click **Tools** menu and select **Restore Partition From Image File** option.

![DiskGenius interface showing restore partition from image file option](image)

**Step 2.** Click **Select Image File** button to find and select the backup image for the partition and click **Target Partition** button to select the partition you want to restore. Then select a restore point for the partition and click **Start** button.
Step 3. Click **OK** to continue when the following message box pops up.

**Note:** Restoring partition will write data backed in image file to the target partition, which removes and overwrites all existing data in the partition. Please close all applications that are using the partition in advance.

Step 4. Click **Complete** button after the partition is restored.
Explorer Partition Image File

DiskGenius is powerful data backup software which helps backup any partition to an image file so that you can restore data when partition gets corrupted. Besides, this program supports browsing and extracting data in image file without restoring partition.

Step 1. Click Tools menu and select Explorer Partition Image File.
Step 2: Browse your computer and locate the image files from which you want to retrieve data and click **Open**.
**Step 3.** Select a time point you want to check and click **Start** button. Then the program starts to load files in the backup image.
Step 4: Select files you want to retrieve and copy them to a desired location.
Clone Partition (Copy Partition)

Cloning partition is the process that copies content of one partition on the disk to another partition without any data loss. The destination partition will be loaded with same data as the source partition. DiskGenius provides three ways of cloning partition:

**Clone partition sector by sector:** A sector-by-sector partition cloning ensures the destination partition is exactly the same as source partition, as it copies all sectors of source partition, including used sectors, blank sectors and bad sectors. The target partition should be equal in size to the partition being cloned.
Copy all valid sectors according to the layout of the file system: This partition cloning method copies all valid data of source partition to destination volume in line with the layout of data organization structure. The cloning process excludes invalid data but does not reorganize data. It is the fastest cloning method. The destination partition and source partition should be in the same size.

Clone partition by files: Copies all files from source partition to destination partition by analyzing data organizing structure. Files in destination partition will be reorganized and there won’t be fragments. The cloning works as long as destination partition is able to hold files to be cloned in source partition.

Step 1. Select the partition you want to clone and click Tools -> Clone Partition.
**Step 2.** Select destination partition and click **OK**.

**Step 3.** Select cloning mode and click **Start** button.
Step 4. Click OK to continue when you see following message box.

**Note:** the cloning process deletes all data of destination partition and writes data of source partition. Please make sure the destination partition does not contain important data.

Step 5. Choose the way to execute partition cloning task.
Step 6. DiskGenius is cloning partition and you should wait for the process to complete.
File Recovery

The File Recovery function applies to recover deleted, lost or formatted files from various storage devices such as hard drive, external HDD, USB flash drive, virtual disk, memory card, RAID, etc. It can also be used to recover lost data from RAW partitions. If you want to recover lost partitions, then refer to Partition Recovery.

**Step 1** Select the drive where lost files were stored and click **File Recovery** button from toolbar. Then **Start** button to search for lost data.

The "Recover Deleted Files" option is used to search for deleted files only, and "Complete Recovery" should be chosen if you want to recover files that
are lost due to other causes, such as formatting, RAW drive, unallocated disk space.

It is recommended to select "Search For Known File Types" when there is write operation or file system gets damaged badly. This option will scan selected area deeply to find out more valuable files. Files found in this way will be listed under "Recovered Types" in scanning result. Sometimes, the "Recover Deleted Files" option cannot find out files that were deleted even just a moment ago. That's because the vital information of deleted files has got damaged. For example, some photos get deleted by mistake, you may open the directory to view files at once. Operating system generates temporary files and caches even when viewing thumbnails. Such actions are more than enough to destroy vital information of deleted file recovery. There are many similar inadvertent operations. In this case, "Search For Known File Types" should be carried out, as it can search for lost files without relying on file records. Although files found by this method do not keep original names, you can preview them to check if they are wanted files.

DiskGenius is scanning the partition:
Step 2. View scanning result.

The main interface of the software displays all found files, and you can view files just like in Windows File Explorer. Also, each file or folder has a check box, and you can easily select those you want to recover.

1. Files listed under **Orphaned Files**

Files or folder listed under Orphaned File are those whose parent directories that they are linked to get deleted or damaged, and the software cannot find the parent folder for them and does not know which folder they belong to. If you cannot find out files you want to recover in the original location, you can have a check of files here.
2. View files listed under **Recovered Types**

Files listed under Recovered Types are found by deep scanning and they are named by numbers. You can identify if you need to recover them via file preview (double-click a file to preview it).
3. Deleted data

In scanning result, some file or folder is tagged with a red or green deletion icon. The green one means the folder contains deleted data, and the red means it is the deleted file/folder.

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>File Type</th>
<th>Attribute</th>
<th>Short Name</th>
<th>Modify Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>pay</td>
<td>Folder</td>
<td></td>
<td></td>
<td>pay</td>
<td>2020-07-08 10:04:22</td>
</tr>
<tr>
<td>payment</td>
<td>Folder</td>
<td></td>
<td></td>
<td>payment</td>
<td>2020-06-23 13:37:11</td>
</tr>
<tr>
<td>payresult</td>
<td>Folder</td>
<td></td>
<td></td>
<td>PAVRES-1</td>
<td>2020-06-23 13:37:09</td>
</tr>
<tr>
<td>pr</td>
<td>Folder</td>
<td></td>
<td></td>
<td>pr</td>
<td>2020-06-23 13:37:10</td>
</tr>
<tr>
<td>public</td>
<td>Folder</td>
<td></td>
<td></td>
<td>public</td>
<td>2020-06-23 13:37:09</td>
</tr>
<tr>
<td>quanguo</td>
<td>Folder</td>
<td></td>
<td></td>
<td>quanguo</td>
<td>2020-07-08 10:04:22</td>
</tr>
<tr>
<td>remote-recovery</td>
<td>Folder</td>
<td>REMOTE-1</td>
<td></td>
<td></td>
<td>2020-07-03 10:04:22</td>
</tr>
<tr>
<td>video</td>
<td>Folder</td>
<td></td>
<td></td>
<td>video</td>
<td>2020-01-07 11:04:41</td>
</tr>
<tr>
<td>WeiBoAPP</td>
<td>Folder</td>
<td></td>
<td></td>
<td>WeiBoAPP</td>
<td>2019-10-10 15:01:24</td>
</tr>
<tr>
<td>wx_sample没...</td>
<td>Folder</td>
<td>WX_SAM~1</td>
<td></td>
<td></td>
<td>2019-10-10 15:01:20</td>
</tr>
<tr>
<td>.htaccess</td>
<td>2.7KB</td>
<td>htaccess</td>
<td>A DX</td>
<td>HTACCESS-1</td>
<td>2019-10-10 15:01:25</td>
</tr>
<tr>
<td>.htaccess</td>
<td>2.8KB</td>
<td>htaccess</td>
<td>A</td>
<td>HTACCESS-1</td>
<td>2020-07-21 16:55:21</td>
</tr>
<tr>
<td>2885813366Qidiao...</td>
<td>32 B</td>
<td>Text File</td>
<td>A</td>
<td>288581~1.TXT</td>
<td>2020-04-02 11:00:54</td>
</tr>
<tr>
<td>301.php</td>
<td>323 B</td>
<td>php File</td>
<td>A</td>
<td>301.php</td>
<td>2019-10-10 15:01:20</td>
</tr>
<tr>
<td>bottom.php</td>
<td>4.0KB</td>
<td>php File</td>
<td>A DX</td>
<td>bottom.php</td>
<td>2020-04-13 10:52:18</td>
</tr>
<tr>
<td>bottom.php</td>
<td>4.3KB</td>
<td>php File</td>
<td>A</td>
<td>bottom.php</td>
<td>2020-06-23 13:37:10</td>
</tr>
<tr>
<td>comment.php</td>
<td>7.3KB</td>
<td>php File</td>
<td>A</td>
<td>comment.php</td>
<td>2020-04-13 10:52:18</td>
</tr>
</tbody>
</table>

**Step 3**: Preview files to check if lost files are corrupted.

Double-click a file in the software and you can view file content on the pop-up window, which is the very way to check if a file is corrupted prior to recovery.
Step 4. Copy files to a different location.

Select files and folders you want to recover data > right-click selected data and choose Copy To > specify a location for recovered data.
Save Scan Progress

DiskGenius facilitates the feature of saving scanning result of the recovery process so that you can resume previous recovery without scanning from the beginning. In general, this program saves scanning progress automatically to the folder where it is located. Besides, you can export the scanning result as a .dgrp file to a specified location and import the file when you restart the recovery.

1. Save scanning result manually
Step 1. Click Tools menu and select Save Scan Progress option when scanning gets finishes or stopped.

Step 2. Name the progress file and set a location to save it. Please note that the file must not be saved to the drive which needs recovering data.
2. Load the scanning result

**Step 1.** Select the partition for which you have saved scan status and click **File Recovery** button to open the recovery window.

**Step 2.** Click the **Load Scan Progress** button.
**Step 3.** Select the file that records the previous scanning progress and click **Open**.
Step 4. Click **Start** button and the program will continue previous recovery.
Recover Files By Type

Sometimes lost files may get damaged or partly overwritten, and they cannot be recovered properly via traditional method; on this occasion, you can try recovering lost data based on file type.

This function performs a deep scanning on selected disk space and finds out lost data via recognizing data layout, so that it is able to recover as many files as possible. This file recovery solution is effective and safe. Currently, more than 100 file types are supported. This feature is included in File Recovery function and it can also be used in the following steps.

**Step 1.** Select the partition which needs recovering data, and click **Tools** menus to choose **Recover Files By Type**:
Step 2. On the next pop-up window, you can set some parameters for the recovery, for example, scanning range, the location to store recovered data, file types you want to recover, etc.
Click "Select File Types" button and select file types you want to recover.

![Select File Types to Recover](image)

**Step 3.** Click **OK** and DiskGenius starts to search for lost files and restore them to the specified folder.

**Note:**

Files recovered in this do not keep original name, and you can filter data via file size, type or file preview.
Load Current Partition Intelligently

This function can be used to retrieve files and folders from damaged or corrupt NTFS partition directly without performing any scanning. For instance, a partition turns to RAW or reports error message like "The file or directory is corrupted and unreadable", lost data will be displayed together with original directory structure after loading the NTFS partition. Note: if the partition is badly damaged, you may need to scan it using File Recovery function to get back lost data.

**Step 1.** Select the inaccessible NTFS partition, click **Tools** menu and select **Load Current Partition Intelligently**.

**Step 2.** Preview data once files are displayed and copy desired data to a different location.
Unlock BitLocker

DiskGenius supports to unlock BitLocker drives with password, recovery key or BEK file, and it can unlock BitLocker encrypted drive on computers whose system does not support BitLocker, such as Windows 10/8/7 Home edition, Windows XP and WinPE.

**Step 1.** Select the BitLocker drive you want to unlock and click **Partition > BitLocker Management > Unlock.**
Step 2. On the pop-up window, you can provide password, recovery key or BEK file to unlock the drive.
Once the drive gets unlocked, you can view files in the software or copy files to a different partition.

Set Volume Name

A volume name, also called volume label, is a drive name assigned by an end user in order to make it easier to recognize.

**Step 1** Select the partition you want to rename and click "Set Volume Name" under "Partition" menu.
Step 2: Type a name in the "Normal Label" box and click "OK".
Convert Partition Type Between Primary and Logical

DiskGenius provides the function to convert primary partition to logical as well as convert logical partition to primary without data loss. One MBR disk may contain 4 primary partitions at most or 3 primary partitions with one extended partition, thus partition converting between primary and logical has some limitations.

Convert primary partition to logical partition

**Step 1** Right-click the primary partition you want to convert and choose "Convert To Logical".

![DiskGenius interface showing Convert To Logical option](image)
Step 2. Click "Save All" button on the tool bar and a message box shows up. Click "Yes" to make the converting take effect.

Note: Since logical partition is 63 sectors bigger than primary partition, there should be at least 63 free sectors in front of the primary partition when changing to logical.

Convert logical partition to primary partition

Step 1. Right-click on the logical drive you want to convert and select "Convert To Primary" option from context menu.
Step 2. Click "Save All" from tool bar and click "Yes" from the pop-up window.

**Erase Sectors**

This feature helps permanently wipe data on any partition or disk sector by sector. Files erased by this function can never be recovered by any data recovery software. Erased sectors can be filled with 00, FF, random data or characters specified by users.

Step 1. Click "Tools" menu and select "Erase Sectors" option as follows, and the Erase Sector window shows up.
Step 2: In the Erase Sectors window, you need to set following options:

1. Select disk or partition you want to erase data.

2. Set sector range to be wiped. If you want to wipe a partition, sectors here mean the partition range.

3. Choose characters to fill sectors.
Step 3. Click Erase button on Erase Sector window and DiskGenius pops up a message box:

Click Erase and OK button to confirm operations to be done and DiskGenius starts to erase data on selected disk space.
Warning: After erasing sectors, all data on the partition/disk cannot be recovered by any software. Please make sure important data has been backed up.

Erase Free Space

It is known to most Windows users that when a file gets deleted from computer, it is not completely removed from disk and can be recovered by data recovery software. Deleted files are not truly gone, and they stay on hard drive before they get overwritten by new data. If you want to completely wipe out deleted files and make them unrecoverable, you can erase free space. This feature only wipes free disk space and leaves existing files intact.

Step 1. Right-click the partition you want to wipe recoverable data and select "Erase Free Space".
Step 2. Click **Erase** button after making sure you've chosen correct partition, and DiskGenius starts to wipe free disk space.
Step 3: Click "Complete" button when it's done.
**4KB Partition Alignment Detection**

Partition 4K alignment is important to improve hard drive performance, and you can check if partitions on your computer are 4KB aligned according to following steps.

**Step 1.** Select the disk for which you want to check partition 4KB alignment and click "Tools" to select "4KB Partition Alignment Detection".

**Step 2.** The pop-up window shows whether partitions are aligned.
Learn more on 4k alignment? refer to that article: [4K Partition Alignment](#).

**Disk Operation**

**Partition Recovery**

How to easily recover lost or deleted partitions? There is an easy method that enables you to recover partitions that are lost due to deletion, disk failure, virus attack, system malfunction, disk repartition, etc. DiskGenius has an easy-to-use GUI which is easy to understand, and it supports to recover deleted or lost FAT, NTFS, exFAT, Ext2, Ext3 and Ext4 partitions.

**Step 1.** Select the disk which needs recovering partition and click **Partition Recovery** button.

If you just want to search for lost partition from unallocated disk space, then select free disk space before clicking "Partition Recovery" button.
**Step 2:** Set searching range and click "**Start**" button and DiskGenius starts to search for lost partitions.
Whole Disk: Scan the entire disk from beginning to end without referring to existing partitions.

All Free Space: Keep existing partitions and search for lost partition from all unallocated space.

The Selected Space: Search for lost partitions from free space of select space only and reserve existing partitions.

Custom Cylinder Range: You can set cylinder range to improve scanning speed if you are sure lost partitions are aligned by cylinder.

The scanning process is read-only, and DiskGenius does not write any data to original disk while searching for partitions. Lost partitions found by the software will not be saved to partition table until you click "Save All" button.
Therefore, if scanning result is not correct, you can repeat searching from step 1.

**Step 3.** Reserve or Ignore partition.

When DiskGenius finds out a partition, it asks whether to reserve it or not. If you want to restore the partition, click Reserve button to keep the partition, otherwise click Ignore to skip this partition. You can preview files in the partition so that you can easily decide whether it is one of the partitions you want to restore.

**Note:**

Since the scanning process is read-only, the partition you choose to reserve is just saved to memory only. You need to save it to partition table by clicking
"Save All" button after scanning so as to finally get the partition recovered. Choose "Reserve" or "Ignore" for each partition found by DiskGenius until scanning completes.

**Step 4.** Click **"OK"** button when DiskGenius finishes scanning.

If you want to cancel this scanning and try to search for lost partitions over again, click "Disk" and select "Reload Current Hard Disk".

**Till now you have two choices to recover data:**

**Method 1:** Select files and folds you want to recover, right-click them and choose "Copy To". Then you can recover files to a different drive.
Method 2: You can click "Save All" button from toolbar or click "Disk" and "Save Partition Table" to save lost partition to current partition table. Lost partitions listed in scanning result will be recognized by system.
Rebuild MBR

MBR, short for Master Boot Record, is a special sort of boot sector, which is located at the beginning of system partition. The function of MBR is telling the boot process as to what is about to follow. Besides, it usually includes some lines of executable code passing the boot process to operating system. If MBR gets damaged, corrupted, or lost, you can follow steps here to rebuild it.

Step 1. Click Disk menu and choose "Rebuild Master Boot Record", as below.

Step 2. Click Yes from the pop-up message box and DiskGenius commits the task.
Clone Disk

Disk cloning refers to copying all partitions and data from one disk to another. During disk copying process, DiskGenius creates partitions on destination disk first and then clones data for each partition. Partitions created on destination disk are identical to those on original disk. There are three disk cloning modes available:

**Copy all sectors**: Copy all sectors of the disk to destination disk without considering whether sectors are in use or not. This clone mode may copy a large amount of invalid data and takes longer time. However, it is the most complete copy method which can copy all the data of the source disk to the target disk.

**Copy all valid sectors according to the layout of the file system**: Copy all valid data of the source disk to corresponding partitions on the destination disk in line with the layout of the file system. Data structure on destination partition will be exactly the same as source partition. Cloning process gets rid of invalid sector, so it is quite fast.

**Copy all files**: Copy all the data of source disk to destination disk by analyzing file system layout of the source disk. When copying data, files will be rearranged according to file system layout. There will not be file fragments and it is very fast.
Note:

1. If the disk to be cloned contains partition whose file system is not supported by the application, it will be cloned via "Copy all sectors" in order to make sure the cloned disk is the same as the original disk.

2. **Copy all sectors** and **Copy all valid sectors according to the layout of the file system** require that the size of destination disk shouldn't be smaller than original disk; **Copy all files** allows to clone larger HDD to a smaller disk, but the capacity of destination disk shouldn't be smaller than the used space of source disk.

**Step 1** Click **Tools** menu and choose "Clone Disk" option.
Step 2: Select the disk you want to clone and click OK.

Step 3: Select destination disk and click OK.
Step 4. Choose a disk clone method and click **Start**.

Only "Copy all files" is available when the target disk is smaller than the source disk.
Step 5. Click "OK" button to continue if you are sure data on destination disk has been backed up.

Step 6. Choose the way to clone disk.

Hot Migration can complete the disk by way of taking snapshots, and it does not require to restart system even when cloning system disk. "Lock &
Execute" means partitions on source disk will be locked temporarily and other programs cannot access them during disk cloning process.

Step 7. Wait for the clone process to finish and click "Complete" button once it is done.
Backup and Restore Partition Table

DiskGenius provides the function to back up and restore partition table, and it is able to back up partition table and boot sectors of all partitions on the disk to a file. When partition table gets damaged, you can recover data from the backup file.

Back up Partition Table

**Step 1.** Select the disk for which you want to back up partition table and click "Disk" to select "Backup Partition Table".

```plaintext
HD2:MsftVirtualDisk(120GB)
Data Size: 8.8GB (18382528 Sectors).

Local Disk(H): 47.0GB
NTFS

Documents(4)
EXT4 42.0GB

Local Disk(I): 31.0GB
NTFS

HD3:MsftVirtualDisk(60GB)

Local Disk(H): 21.1GB
NTFS

Documents(4)
EXT4 18.5GB

Local Disk(I): 20.3GB
NTFS
```

Copy: 4.92 MB Remaining: 6190 MB 7337 MB/min
Time Elapsed: 0:00:40 Remaining: 0:00:50
Step 2. Set a name for the backup file and select a location to save it.
Restore Partition Table

**Step 1.** Select the disk that needs restoring partition table and click "Disk" to choose "Restore Partition Table".

**Step 2.** Locate and select the backup file and click Open.
Step 3. Click **Yes** to give confirmation and DiskGenius restores partition table from backup.

**Create Bootable USB Disk**

DiskGenius is capable of creating USB bootable disk and USB-FDD, USB-ZIP and USB-HDD boot methods are supported. This function can converse USB flash disk (or USB hard drive) into FDD or ZIP mode and build bootable DOS system, which can be used to boot computer. For computers supporting USB boot, such boot disk can be used when restoring system. Nowadays,
motherboard manufacturers have no agreed standards to USB boot mode; FDD, ZIP, HDD are the popular modes today. You can choose one according to the mode motherboard supports.

**Note:** If you have any files on the USB disk (or memory stick), copy them to a hard disk first as they will be destroyed by the following process.

**Create USB-FDD bootable disk**

**Step 1.** Select the USB drive and click *Tools* to choose *Convert To USB-FDD Bootable Mode* option.
Step 2. Click **Yes** to continue if you've backed up important data for the USB disk.

![Dialog box showing confirmation message](image1)

Step 3. Select file system and click **"Convert"** button. Then DiskGenius starts to convert disk and copy DOS boot files to it. Besides, you can also set cluster size, volume label, driver letter before converting.

![DiskGenius interface showing file system selection](image2)

Step 4. Click **OK** button and reinsert the USB disk.

![Message box showing conversion completion](image3)
Create USB-ZIP bootable disk

Select the USB disk you want to make bootable disk, click **Tools** and choose **Convert to USB-ZIP Bootable Mode**.

The rest operations are the same as creating a USB-FDD bootable disk.

Create USB-HDD bootable disk

The HDD mode is the regular hard drive boot mode. When you start a computer, it loads hard drive master boot program which looks for active partition; and the control right is transferred to operating system of the active
partition. Normally, the conversion is not necessary, and what you should do is to create a partition and format it on which you create a DOS system. If the current disk is working in FDD or ZIP mode, this function can convert it to HDD mode. Detailed steps are in the following:

**Step 1.** Select the USB disk to be created bootable disk and choose "Convert To HDD Mode" from **Tools** menu.

**Step 2.** Click **Yes** button to continue if files on the disk have been well backed up. Then DiskGenius converts the disk to HDD mode immediately.
DiskGenius asks whether to create a bootable partition, as below:

![Image of DiskGenius warning]

After converting to HDD mode, all partitions and files on disk 'RD4:SMIUSBDISK(15GB)' will be deleted. The disk will be able to be repartitioned. Are you sure to convert it to HDD mode?

[Yes] [No]

Click **No** and DiskGenius won't create a partition after conversion, and you can use the disk normally; if you choose **Yes**, and "Create New Partition" dialog box pops up.

![Image of DiskGenius prompt]

Convert to HDD mode completed. Create a bootable partition now?

[Yes] [No]
Click "OK" after selecting file system type and partition size, and DiskGenius will create a new partition immediately and copy DOS system to the newly created partition. The conversion of HDD mode is done!

**System Migration**

DiskGenius provides the function to help you migrate Windows operating system and installed applications to SSD or HDD without reinstallation of OS and apps. The disk can be smaller than the source disk, and yet it should be large enough to hold the system you are going to migrate. Here is the step-by-step guide of system migration.
Step 1. Run DiskGenius and click **System Migration** button from toolbar, or choose **Tools > System Migration**.

Step 2. From pop-up window select the destination disk and click **OK**.

Warning: files and partitions on target disk will be erased, please make sure you've backed up important files beforehand.
**Step 3** Set partition size on target disk.

You can drag arrows between partitions to set partition size on destination disk.
If your computer uses the modern UEFI, you can also set whether to change computer boot sequence, for example, if you choose "Automatically set to boot from migrated target system", your computer will boot from target disk automatically. If you want to continue booting from original disk, just leave this option unselected.
Step 4: View settings and click **Start** button.
Click **OK** if all files on target disk have been backed up.

**Step 5.** Select system migration method.

Hot Migration: DiskGenius migrates OS to target disk without shutting down system.

Reboot to WinPE: Computer will reboot to DiskGenius WinPE edition to complete system migration.
Step 6: Wait for the OS migration process to complete.

**Note:** The system migration process will erase all existing data and partitions on target disk, please be sure important files on the disk have been backed up in advance.
Do not in a hurry to format original system disk or wipe data before making sure your computer can boot from target disk successfully.

**Check and Repair Bad Sectors**

Bad sectors on hard drive or other storage devices are not accessible or writeable due to damage on the disk. If you suspect there are bad sectors on your disk, you can use DiskGenius to check or repair bad sectors.

**Check bad sectors**

**Step 1** Select the disk you want to check or repair bad sectors and click **Disk** menu to choose **Verify Or Repair Bad Sectors**, also, you can right-click the disk and choose the option form context menu.
Step 2. Click "Start Verify" button and DiskGenius starts scan the disk and check if there is any bad sector.

You can set cylinder range and timeout value before verifying bad sectors. If you are not familiar with these settings, then follow default settings.

Disk conditions are presented by blocks in different colors, for example, red block with "Damaged" means bad sectors, and "Severe" blocks are likely to turn to bad sectors.
Step 3. Click **OK** button when scanning finishes.
Repair bad sectors

Note:

Checking bad sector is read-only, but repairing bad sector destroys data saved on or near bad sectors. Please backup or recover data before trying to repair bad sectors.

Not all bad sectors can be repaired by software, such as physical bad sectors are not repairable.

In consideration of data security, it is not advised to use a disk that contains bad sectors even after bad sectors get repaired. Do not save important data on that disk.

**Step 1.** Click "Repair" button when DiskGenius finishes bad sector scanning.

**Step 2.** Click "OK" button if you've backed up all data on the disk.

**Step 3.** Click "OK" button if there is no need to recover data from the disk.

Then DiskGenius starts to repair bad sectors.
Step 4. Click "OK" when bad sectors get repaired.

View S.M.A.R.T. Information

DiskGenius, freeware for hard drive diagnostics, can test storage device for errors such as bad sectors, modify HDD parameters and show S.M.A.R.T. attributes. You can perform regular hard drive rest to predicate potential problems so that you will be able to protect data against loss due to hard drive damage.

S.M.A.R.T. (Self-Monitoring Analysis and Reporting Technology) is a feature on hard drive to monitor indicators of disk reliability. Windows does not provide an easy tool to view hard drive's S.M.A.R.T. data, but you can use DiskGenius to check this information.

Step 1. Select the disk you want to check its S.M.A.R.T. information and click "View S.M.A.R.T. Information" option from Disk menu.
Step 2: A window pops up and you can view detailed S.M.A.R.T. data such as Serial Number, Health Status, Temperature, Power-on Hours, etc.
Quick Partition

This function is designed to quickly partition a new disk or repartition a hard drive that contains partitions already. A hard drive can be partitioned via a few simple operations. If you do not want to change default settings on partition count, size, type, label, etc. open "Quick Partition" window and click OK button, and the disk will be repartitioned and formatted. Note: Disk repartitioning removes all existing partitions on the disk and quick formats each new partition.
Step 1. Select the disk you want to partition and click "Quick Partition" button or press F6 from keyboard. The Quick Partition window pops up as below:

![Quick Partition window](image)

Step 2. Set partition table type, partition count, size, label, etc. and click "OK" button. Then DiskGenius starts to partition the disk and format new partitions.

If the disk contains partition, the following message box will show up. Click "Yes" to continue, otherwise click "No" to cancel.

![Alert message](image)
Notes

Select disk

You can click the disk shown under "Current Disk (Click to Change)" to reselect a disk to partition without going back to the home interface. DiskGenius does not allow to partition system disk under Windows environment, but you can create a bootable disk to boot computer and partition system disk. Warning: please make sure you are selecting the correct disk, as the partitioning process deletes all existing partitions on selected disk.

Partition Table Style

Both MBR and GPT disk style are supported to partition your disk. MBR is the default setting if the disk capacity is less than 2TB. Besides, Rebuild MBR (Master Boot Record) is selected for MBR disk and it is recommended to leave it checked if there is boot manager based on MBR on the disk and it needs to be reserved. If you select GUID partition table style, you can choose whether create ESP partition or MSR partition.

Partition Count

You can either press "3, 4, 5 or 6" key from keyboard or use mouse to set partition count. Besides, you can also custom partition count by selecting Custom option. Once selecting a partition count, the corresponding partition number changes on the right side of the pane.

Partition Parameters

File System: NTFS, FAT32 and exFAT are available here to choose. If you want to format the drive to other file system such as EXT4, you can reformat partition with DiskGenius after the disk is partitioned.
Partition Size: The program sets default size for each partition based on disk size, and you can change size by entering a desired number.

Volume Label: Each partition is set a volume label by default, and users can modify it by typing a name or selecting from the drop-down list.

Partition Type: Select Primary and the partition will be a primary partition. This option is not available for GPT disk.

Reserve sectors between partition: Set partition gaps

Align Partitions to Integral Multiple of Sectors: The role of this option is 4K alignment and the default value meets 4K alignment requirement.

**Delete All Partitions**

This function is able to delete all partitions on a disk.

**Step 1.** Right-click on the disk and select "Delete All Partitions".
Step 2. Click "Yes" if you are sure there is not important data on the disk.

Step 3. Click "Save All" button from toolbar and click "Yes" button.

To prevent data loss due to improper operation, the delete partitions operation will not be saved to disk immediately, it is kept in the memory until you save partition table.
Copy Sectors

This feature is designed to create a sector-by-sector copy of disk, partition or a defined number of sectors. It copies specified sectors no matter they are used or not on selected disk, even though the sector does not contain any data or gets damaged. Thus, you can get a copy or image that is identical to original disk or partition. Both source and destination can be a partition, disk or file.

**Step 1** In DiskGenius, click Tools and choose Copy Sectors.
The copy sectors window shows up:
Step 2. Select source and destination disk (or image file).

You can click the disk icon to select a disk (partition) or click the file icon to select a file.
Step 3. Configure settings for the sector copy process.

A couple of options are provided to help you control the copy process when bad sectors are encountered on the source drive, and you can configure this based on actual condition of the drive to be copied.
1. When encountering bad sector area

**Skip a defined number of sectors (128 by default):** When the process fails to read a certain buffer, it changes to read 128 sectors at a time. If that fails again, it turns to read sectors one by one. When a bad sector is encountered, it skips the specified number of continuous sectors and writes zeros (or fills with defined strings) to these sectors' counterpart on target disk. Then it continues to read 128 sectors at a time until finish reading the entire buffer.

**Sector-by-sector copy:** When the process fails to read a certain buffer, it changes to read 128 sectors at a time. If that fails again, it turns to read sectors one by one. When a bad sector is encountered, it does not skip it.
Instead, it writes zeros (or fills with defined strings) to the bad sector’s counterpart on target disk and continues to read remaining sector of the 128 sectors one after another. After that, it reverts to reading 128 sectors each time until finishing reading the entire buffer.

**Skip large segment of sectors to try later:** When the process fails to read a buffer, it writes zeros (or fills with defined strings) the entire buffer and skips a large segment of sectors (around 10%-15% of the entire range to be copied). Those skipped sectors will be copied again after all segments are copied (skipped).

**Try to copy bad sectors after normal sectors are copied (time-consuming):** If this option is selected, the program will recopy every previously skipped segment of bad sector after normal sectors are copied. When recopying skipped sector segments, the program attempts to copy 128 or 8 sectors at a time according to the size of sector segments. If the attempt fails, it will read sectors one by one. It automatically switches to read the rear end of the segment when reading the beginning part fails, and it will try next segment until all sectors of this segment have been successfully copied or confirmed to be failed. This option will be disabled (greyed out) when you choose "Sector-by-sector Copy"; and this option must be selected when you choose "Skip Large Segment Of Sectors To Try Later".

**Fill bad sectors with strings:** This option is used to specify strings to fill bad sectors. When bad sectors are encountered, the corresponding sectors on destination disk will be filled with specified strings. If you do not select this option, the corresponding sectors on destination disk will remain unchanged (do not copy failed sectors) when bad sectors are encountered on the source disk. It is recommended to check this option when copying sectors for the first time, so that you can recopy those filled sectors.
Recopy filled sectors of target disk: Before starting copying process, the program reads and analyzes sector data on target disk, adding sectors filled with specified strings to the sector list to be copied and filtering out unfilled sectors. When analysis gets completed, it copies sectors in the list only. With this option selected, those skipping options will be disabled and the option "Try To Copy Bad Sectors After Normal Sectors Are Copied (time-consuming)" will be automatically selected.

2. Reverse copy (from back to front)

The program copies sectors of a disk in reverse direction, backward from the end of the source disk. When bad sectors are encountered, it skips defined number of sectors from back to front.

3. After completed

With this option, you can preset what to do after the copy process completes, including, shut down, restart, stand by and hibernate.

Step 4: Click Copy button to start copying sectors and wait for the process to complete.
The sector copy process will damage and overwrite files on target disk, please make sure there is not important data on target disk. Click Yes to continue.

When copying sectors between different disks, dual threads are used to speed up the process; while if sectors are copied on the same disk, it turns to simple thread so as to reduce frequency of head seek and make full use of read and write performance.
The progress is clearly displayed on the lower part of the dialog box, including overall progress bar, current sector being copied, the amount of data has been copied, remaining data, speed, time elapsed, remaining time, etc.

Other features

1. Copy report: During the copying process, a copy report (a text file and the file name contains the starting time) is automatically saved to the folder where the software is installed, and the report gets updated every two minutes. The report covers information like source and target disk, copy parameters, sector list to be copied, the list of successfully copied sectors, the amount of data that was successfully and unsuccessfully copied, starting and
ending time, etc. The report will be opened automatically after sector copy process completes.

2. If you want to power on the source disk again which is offline or has been stuck for a long time, you can click **Stop** button. Then you can reconnect the disk after the copying process stops. Once the disk is recognized by the software, you can click **Continue** button to resume the copy process.
In addition, the software will automatically stop the copy process when detecting the source disk is offline and prompt to power on the source disk.

![Image](image_url)

3. After the process gets completed (not interrupted), the dialog box won’t close and the option "Recopy Filled Sectors of Target Disk" will be selected if there are bad sectors that are still failed to copy and strings that have been specified to fill bad sectors. At this point, you can click **Continue** button to try to copy those bad sectors again.

4. A file recording copy progress is automatically stored to the software directory after copy process gets completed or interrupted. With this file, previous settings will be automatically loaded when you open Copy Sector window next time. If the **Copy** button turns into **Continue** button, which means you can resume the last unfinished progress.

If the last copy got interrupted, after loading progress, you can click **Continue** button to continue copying sectors.

If the last copy is completed but there are sectors failed to copy, the option "Try To Copy Bad Sectors After Normal Sectors Are Copied (time consuming)" will be automatically selected after loading progress. Then the process will try to copy those failed sectors again.

After loading progress, the software will ask whether to follow new settings if options on the dialog box get changed.
Clear Reserved Sectors

For DiskGenius, reserved sectors refer to sectors from the second sector (behind MBR sector) to the sector that is in front of the beginning sector of the first partition. In most cases, a track has 63 sectors, and the first partition usually begins at the 63rd sector (it numbers from 0), so, excluding MBR sector, there are 62 sectors to be cleared.

As to the case that sectors are not 63 or the first partition doesn't begin from the 63rd sector, DiskGenius automatically calculates sector number to be cleared so that it won't clear other sectors except reserved sectors. This function doesn't apply to GPT disk with GUID partition table.

**Step 1.** Select a disk you want to clear reserved sectors, then click "Disk" and "Clear Reserved Sectors".
Step 2. Click "OK" to execute the operation.
Convert Partition Table Style

DiskGenius supports both MBR and GPT disk, and it is able to change an MBR disk into a GPT disk or convert a GPT disk into an MBR disk. The converting does not cause any data loss.

Convert MBR to GPT

**Step 1.** Right-click the MBR disk you want to change partition table type and choose "Convert To GUID Partition Table".

**Step 2.** Click "Save All" button from toolbar and click "Yes" to save changes to the disk.
**Note:**

It requires there is some free space (dozens of sectors) on the two ends of the disk before converting.

Please make sure the operating system on the disk supports GUID partition table after converting, otherwise partitions might become inaccessible.

**Convert GPT to MBR**

**Step 1.** Right-click on the GPT disk and select "Convert To MBR Partition Table" option.
Step 2. Click "OK" when you are asked whether to convert partition table to MBR.

Step 3. Click "Save All" button from toolbar and click "Yes" to save changes to the disk.
Check and Correct Partition Table Error

DiskGenius provides the function to check and correct errors on partition table. If partition table on the disk contains serious problem, DiskGenius will reports errors immediately after being launched.

**Step 1.** Select the disk for which you want to check partition table error, then click "**Tools**" and choose "**Check Partition Table Error**".
Step 2. The "Partition Table Problem Report" window shows errors on the disk. Click "Correct" button and DiskGenius tries to fix the error.

The disk HD2:MsftVirtualDisk(120GB) has partition table problems as shown below:

<table>
<thead>
<tr>
<th>Partition</th>
<th>Error Description</th>
<th>Correction mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Warn: Warning: No active partition</td>
<td>Correct parameters</td>
</tr>
</tbody>
</table>

Note: The operation of "recreating or reformating" will not be executed when you click the "Correct" button. Please do it manually after all other errors are corrected.

Step 3. Click "Save All" button on toolbar and click "Yes" to make changes take effect.

Are you sure you want to write all change to disk? The change will take effect immediately.
Appoint Disk Geometry

Hard drive geometry is the organization of data on disk platters, and it decides how and where data is stored on the surface of each platter. This function is used to appoint hard disk geometry such as sector size, heads, sector per track, cylinders, total sectors, and boot record (DBR) of each partition.

Please note that this feature configures parameters used in partition table. In some case, after saving partition table, disk parameters might be changed. Thus, operating system may not be able to boot normally after changing hard disk geometry. Do not make any changes if you do not fully understand this function.

**Step 1.** Right-click the disk you want to change geometry and choose "Appoint Disk Geometry" option.
Step 2. Enter parameters on the following dialog box and click "OK".
Batch Format USB Disk

This function allows to format multiple USB drives at a time. When you insert a USB drive which matches settings in the software, DiskGenius starts to format it automatically.

**Step 1.** Click "Tools" menu and choose "Batch Format USB Disk" option.
Step 2 Define specific conditions for formatting.

Settings under "Select Target Disk" can be used to define conditions for USB disks you want to format. Only when the inserted USB disk meets all conditions you set up, can it be formatted automatically by DiskGenius; otherwise, the disk will be untouched.
Step 3. Insert USB disks that meet conditions set in previous step and DiskGenius automatically formats them.

The program can automatically eject drives when formatting is done.
Convert Dynamic Disk to Basic Disk

DiskGenius is professional partition management software as well as an easy-to-use dynamic disk converter. It is able to convert dynamic disk to basic disk without data loss and the converting takes only several seconds.

**Step 1.** Right-click on the dynamic disk you want to convert and select **"Convert To Basic Disk"**.

**Step 2.** Click **OK** button to confirm the option.

**Note:** After converting, the disk cannot be converted to dynamic disk by the program.
Step 3. Click "Save All" from toolbar and click "Yes" to save changed to disk.

Safely Eject Disk

This function enables you to safely remove USB disk, which works the same as the way operating system eject removal devices.

Select the USB disk you want to remove and click Disk menu to select Safely Eject Disk.
When the disk is ejected, you can unplug it from computer's USB port.
Set UEFI BIOS Boot Entries

DiskGenius is a free and useful tool to manage UEFI boot options in Windows, and it enables you to carry out various tasks such as, edit, backup, restore, delete, create UEFI boot options, change boot sequence, disable/enable a boot entry, specify a one-time boot for next restart, boot to UEFI firmware settings from Windows, etc.

**Step 1** Launch DiskGenius and choose **Tools > Set UEFI BIOS boot entries**.
Step 2. On the pop-up window, you can manage UEFI boot entries based on your own requirements.

**Virtualize System into VMware Virtual Machine**

DiskGenius supports to convert current Windows system (Windows 10/8/7/Vista and Windows Servers) into a VMware virtual machine, and then you can boot the system in VMware.

Step 1. Launch DiskGenius on the computer you want to migrate to VMware, click **Tools** menu and choose **Virtualize Current System Into VMware Virtual Machine**, as follows:
Step 2: Click **Create disk** button to create a virtual disk.
Step 3. Click the option button to specify a location to store the virtual disk.

Set a location and name the file and click **Save** button.
Click **Create** button to create the virtual disk.
Step 4. Set virtual machine name, processors and memory size and click Create button.

Step 5. Click Start button to migrate current operating system to the virtual disk created in step 3.
Choose **Hot Migration**. Hot Migration is the recommended option, as it can perform system migration in the background.

Wait for the process to complete.
Step 6. Open the virtual machine in VMware: launch VMware Workstation > File > Open.
Find the virtual machine you just created and click Open.
Click Power on this virtual machine and you can boot the migrated system in VMware.
Virtualize System into VirtualBox Virtual Machine

DiskGenius supports to convert Windows operating system (Windows 10/8/7/Vista and Windows Servers) into VirtualBox virtual machine, and then you can boot the system in VirtualBox.

**Step 1.** Launch DiskGenius on the computer you want to migrate to VMware, click "Tools" menu and choose "Virtualize System Into Virtual Machine" - "VirtualBox", as follows:

**Step 2.** Click "Create disk" button to create a virtual disk (the VDI file).
Step 3. Click the option button to specify a location to store the virtual disk.

Set a location and name the file and click "Save" button.
Click "Create" button to create the virtual disk for VirtualBox.

**Step 4.** Click "Create" button when the program back to the "VirtualBox Virtual Machine Settings" window.
Step 5. Click "Start" button to migrate Windows operating system to the virtual disk created in step 3.
Choose "Hot Migration". Hot Migration is the recommended option, as it can perform system migration without shutting down or restarting computer.

Wait for the process to complete. After that, you can load the virtual disk in VirtualBox and boot VirtualBox from the migrated Windows.
TRIM Optimization

TRIM is a command that enables operating system to inform SSD which data is no longer valid and can be erased. Without TRIM, the SSD cannot know which file has been deleted until operating system requires some data should be written to the same place. In this case, the SSD cannot maintain speedy performance. Enabling TRIM for SSDs and hard drives that supports TRIM (SMR hard disk drives) can help improve write performance and extend lifespan. DiskGenius provides TRIM optimization function by which you can manually optimize a partition which is accessible in Windows or an entire disk, and here is how:
**Step 1** Right-click the partition or disk you want to execute trim optimization, and choose **TRIM Optimization**, as follows:

Optimize current partition via TRIM technology
Optimize current disk via TRIM technology

**Step 2**  A message box pops up, prompting the TRIM optimization process will immediately wipe delete data from the disk. Click **OK** to continue.
Step 3. Wait for the process to complete.
**Operate Windows Storage Pool and Storage Space**

Windows Storage Space is similar to RAID technology configured by software, helping users protect data against physical disk failure as well as improve read and write performance. Users can group multiple physical disks into a Storage Pool where Storage Spaces can be created. Storage Space provides Resiliency Types to protect data via redundancy, such as Two-way Mirror, Parity. DiskGenius supports Storage Spaces created by all Windows systems, enabling users to perform data recovery, disk management, and data backup from it.

Connect disks related to your Storage Pool to a Windows computer, and then open DiskGenius. The software will automatically detect them and Storage Spaces, see the picture below.
"Disks" and "Storage Pool" tabs

Once the software detects disks that belong to a Storage Pool, "Disk" and "Storage Pool" tabs will appear in the partition directory tree area.

Click "Disks" tab, and you can view attached regular disks and all components of your Storage Pool (disks related to the Storage Pool and Storage Spaces). Storage Spaces here are mounted via Windows, and you can operate them just like regular drives.
Select "Storage Pool" tab, and you can view Storage Spaces parsed by DiskGenius.
In some cases, DiskGenius is still able to load Storage Spaces when the version of Windows you are using does not support Storage Space or Storage Space goes wrong. Once DiskGenius recognizes Storage Spaces and files correctly, you can back up files directly to avoid data loss.
View detailed information

Right-click a Storage Space or any disk from Storage Pool and select "View Storage Pool Information"; or click menu "Disk" -> "View Storage Pool Information" item.
"View Storage Pool Information" pops up, showing parameters in detail.
Storage Pool Information: present description (the information user entered during creating the Storage Pool), GUID and number of related disks.

Storage Space Information: Select a Storage Space from the drop-down list, and you can view its information like description (the information user entered during creating the Storage Space), GUID, size, provisioning type, resiliency type, number of columns, number of data copies and disk redundancy.

Related Disks: Disks related to the selected Storage Pool are listed here; the sign "*" means the disk is actually used by currently selected Storage Space; if some disk is missing, there will be a "Related disk(s) are missing" error.
Virtual Disk and Image Files

Create VMware Virtual Disk File

DiskGenius supports to create VMware virtual disk file and manage files and partitions on it.

1. **Step 1** Launch DiskGenius and select menu "**Disk**" -> "**Create New Virtual Disk File**" -> "**Create VMware Virtual Disk File**".

2. **Step 2** Set file path, name, capacity, etc. and click "**Create**" button. Then the virtual disk will be created.
Create Virtual PC Virtual Disk File

DiskGenius is capable of creating Virtual PC virtual disk files (".vhd" file) and operating its partitions and files. Operation steps of creating a virtual disk file are in the following:

**Step 1.** Click "Disk"-> "Create New Virtual Disk File"-> "Create Virtual PC Virtual Disk File", as below:
Step 2. Set the file path, name and capacity, and click "Create" button. Then the virtual hard disk file will be created.
Create VirtualBox Virtual Disk File

DiskGenius allows to create VirtualBox Virtual Disk File (VDI) and manages files and partitions on the disk without running the virtual machine.

**Step 1.** Click the menu "Disk" -> "Create New Virtual Disk File" -> "Create VirtualBox Virtual Disk File", as follows:
Step 2. Set file path, file name and capacity; also, if necessary, you can check the option "Allocate all disk space now". Click "Create" and the virtual disk file will be created.
Create Parallels Desktop Virtual Disk File

DiskGenius supports to create Parallels Desktop virtual disk file and manage files and partitions on it in Windows.

**Step 1.** Launch DiskGenius and select menu "**Disk**" -> "**Create New Virtual Disk File**" -> "**Create Parallels Virtual Disk File**".

![Create VirtualBox Virtual Disk (vdi File)](image-url)
Step 2. Set file path, name, capacity, etc. and click "Create" button. Then the virtual disk will be created.
Create ".img" Image File

DiskGenius supports uncompressed image file of disk and partition. It is able to open and operate all kind of image files as long as it is in compressed format, such as ".img", ".ima", ".vfd" and ".flp". The following steps show how to create .img image file.

**Step 1** Click "Disk" → "Create New Virtual Disk File" → "Create .img Image File", as follows:
Step 2. Set file path and capacity and click **OK** button to create the image.

You can select a capacity from the five built in standard floppy image size: 360K, 720K, 1.2M, 1.44M and 2.88M; also, you can specify a capacity by yourself and then you can select an image type, "Disk Image" or "Partition Image". Disk Image is just like a real disk which can be repartitioned; Partition Image is similar to floppy disk image which can only be formatted not repartitioned.

By default, DiskGenius builds bootable DOS system in the image when it is created. Thus, this bootable image file can be used to boot a virtual machine or make bootable CD. Due to the software copyright, DiskGenius adopts FreeDOS which is small, free and compatible with MS-DOS. If you do need to
use MS-DOS system, you can just replace files of the folder "dos" in the directory of DiskGenius with MS-DOS system files.

DiskGenius opens the image file once it is created. Besides, you can add other files to the image by using the function of copying files.
Virtual Disk File and Its Partitions

DiskGenius is able to load virtual disk files and ".img" disk image without launching virtual machine. Once virtual disk is loaded, you can recover lost data from the disk as well as manage disk space, for example, create partition, resize partition, image disk, copy partition, etc. It supports VMware, Virtual PC and Virtual BOX virtual disks.

Click "Disk" menu and select "Open Virtual Disk File", as below:
Select the virtual disk or disk image you want to open and load it. Then you can view the disk in DiskGenius.

The virtual disk is loaded in DiskGenius instead of operating system; thus it is not visible in File Explorer and its partitions cannot be assigned drive letters.

After opening a virtual disk, you can operate it as a regular disk. All functions, except assigning drive letters, can be performed to the disk, for instance, format partition, copy files, file & partition recovery, clone disk, image partition, resize partition, etc. Detailed operations to partitions and files are the same as operating a regular disk.
Convert Virtual Disk Format

DiskGenius can manage partitions, recover deleted files and backup data for virtual disks including VMware (".VMDK"), Virtual PC (".VHD") Virtual Box (".VDI") and Parallels Desktop (".HDD"). It is an efficient converter to convert virtual disk format without data loss.

Step 1. Click "Disk" menu and select "Convert Virtual Disk Format", as below.
Step 2. Select virtual disk to be converted, choose virtual disk format and set path. Click "Convert" button and DiskGenius starts to convert virtual disk format.

Source Virtual Disk: Click "Source Virtual Disk" button to select the virtual disk you want change format.

Convert: Click the dropdown list to select a virtual disk format you want to convert.

Save: Click "Select" button to name the converted virtual disk and set a location to save it.
Construct Virtual RAID

This function serves construct a virtual RAID from its drives and then you can search for lost files or partition from it. Data can be recovered in the same way that they would from normal storage devices.

Please note that the constructed RAIDs are just virtual objects and DiskGenius does not do any writing actions to it. Before starting, you should detach disk from the RAID controller and attach them to computer as individual drives.

**Step 1.** Click "Tools" and select "Construct Virtual RAID" as follow:

The "Construct Virtual RAID" window opens:
**Step 2.** Click "Add Disk" or "Add Partition" to add drives. Also, you can modify disk order by clicking "Move Up" or "Move Down" button.
Step 3: Select RAID type and block size and click OK button to construct the virtual RAID.
If the virtual RAID is not correctly constructed, you can recompose it by clicking "Recompose Virtual RAID" as follows.
Disk Sector Editor

Summary

DiskGenius includes a hex editor which can be used by advanced users to fulfill various tasks such as data recovery, file analyzing, editing data structure, cloning disk, etc. If you do not have a good command of related knowledge, do not try this function in case any improper operation damages data.

Run DiskGenius, select a partition and click the tab "Sector Editor" to launch sector editor.

The sector editor consists of five parts:
1. Toolbar

From left to right: save, copy, paste, undo, find hex values, find text, go to offset, go to sector, last sector, next sector, go to first sector, go to last sector, last cursor, next cursor, interpret as partition start, endian convert, calculator and directory browser.

2. Directory browser

This part shows files and folders of the partition whose sectors are being edited. The place of currently selected item can be reached by using context menu (e.g. beginning sector of file, file record, index, parent directory record, directory entry and beginning sector of parent directory). Double click the folder to visit its files and click the mark ".." to return to parent directory.

3. Interpreter
This area interprets current cursor. When legal and valid data is entered the edit box, the interpreter will automatically convert it to corresponding hex value and write it to area ④, which saves manually conversion. Here are the types it can interpret:

1) Signed and unsigned (8 bit, 16 bit, 24 bit, 32 bit, 40 bit, 48 bit, 56 bit, 64 bit).

2) GUID: GUID (Global Unique Identifier) is a 128-bit number identifier produced by algorithm.

3) Time and date: C Date is a 32-bit integer value, representing seconds since January 1, 1970; DOS Date is used by several DOS function calls and by all FAT file systems, and the lower word determines the time, the upper word the data; FILETIME is a 64-bit integer value representing the number of 100-nanosecond intervals since January 1, 1601. Used by the Win32 API.

4) Binary number.

4. Edit area

This area divides into three parts: offset area, hex edit area and text edit area. Mouse dragging is supported. Changed part will turn red, otherwise keeps black.

1) Offset area: show address in hex.

2) Hex edit area: user can enter characters (0-9 and A-F).

3) Text edit area: user can enter characters (ASCII).

4) Context menu introduction.

5. Status bar
This area shows the current sector and sector count, offset, interpretation of current cursor, range of selected blocks and block size. Also, it supports copying through right mouse button (hex and decimal).

**Sector Editor Common Functions**

Shortcut buttons of common functions are provided in sector editor:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>FileType</th>
<th>Attribute</th>
<th>Short Name</th>
<th>Modify Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>$Recycle.Bin</td>
<td></td>
<td>Folder</td>
<td>HS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Documents and Setting</td>
<td></td>
<td>Folder</td>
<td>HS</td>
<td>DOCUMENT~1</td>
<td></td>
</tr>
<tr>
<td>Intel</td>
<td></td>
<td>Folder</td>
<td>Intel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>M1130MFP_M1210M</td>
<td></td>
<td>Folder</td>
<td>M1130M~1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OneDriveTemp</td>
<td></td>
<td>Folder</td>
<td>H</td>
<td>ONEDR~1</td>
<td></td>
</tr>
<tr>
<td>PerfLogs</td>
<td></td>
<td>Folder</td>
<td>R</td>
<td>PROGRA~1</td>
<td></td>
</tr>
<tr>
<td>Program Files</td>
<td></td>
<td>Folder</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here explains how to use these buttons in detail.

1. **Sector location**

   a. **Find hex values**

   Enter related searching criteria to find hex values, as below:
Support searching with multi criteria
Build in commonly used searching contents
Support wildcard
Support searching in all directions: all, up and down
Support setting searching offset
Support selecting conditions: "meet one" or "meet all"

b. Find text

It can search for required text files quickly as follows:
Support searching with multi criteria
Support searching through matching case
Support wildcard
Support searching in all directions: all, up and down
Support setting searching offset

c. Go to offset

Values in the drop-down box can be saved after the jump, so that they can be selected next time when the drop-down box is opened again.

d. Go to sector

Go to the appointed sector rapidly, as below.
1). Logic (LBA): you need to enter sector or cluster number (which is enabled only when the open method is partition).

2). Physical (CHS): these parameters "cylinder/track", "head/surface", and "sector" are needed.

e. Go to appointed sector rapidly

Go to last or next sector and go to fist and final sector.

f. Go to cursor quickly

Go to the first or last cursor quickly.

2. Edit sectors

Data on the sector where cursor stays can be viewed or edited
As shown in the picture above, the offset, hex values and further interpretation of the current cursor can be seen on the interpreter of the right interface. And you can edit the data where the cursor stays either in the text edit area or hex edit area.

a. Copy and paste

Locate the cursor to set the beginning sector and drag the mouse button to the end of a certain data area, and the selected area turns light blue.
Click the button "Copy" to copy data of the selected area to clipboard, and then locate cursor to the beginning of target area and click the button "Paste". The copied data turned red as follows:
b. Save and undo

Those operations to sectors don't actually modify data on the hard drive before you click the button "Save", and operations can be canceled after clicking the button "Undo".

Warnings: Data will be modified forever after clicking "Save" button, and it can't turn to previous state, so be careful!

3. Others

a. Interpreter as partition start

This function interprets the current sector where cursor stays as partition start. If the sector's data conforms to the data feature of partition beginning, system will identify partition size automatically; otherwise, system will ask you to input partition size.

The interpreted partition will be listed on the left interface with lighter color than normal partitions.
b. **Endian conversion**

The endian conversion affects data interpreter which is interpreted as little endian by default.

1). Little-Endian means that the low-order byte of the number is stored in memory at the lowest address, and the high-order byte at the highest address.

2). Big-Endian means that the high-order byte of the number is stored in memory at the lowest address, and the low-order byte at the highest address.

c. **Calculator**

Use calculator to calculate sector quickly.
d. Directory browser

This area shows files and folders of the partition.
Shortcut Menu

DiskGenius provides shortcut menu to facilitate sector editing.

Context menu of directory browser

This menu includes commonly used functions as well as functions about sector edit.
a. Beginning sector of file: go to the sector where the current selected item stays.

b. File record (enabled when file system is NTFS): go to the sector of file record where the current selected item stays.

c. Index (enabled when file system is NTFS): go to the sector of index record where the current selected item stays.

d. Parent directory record (enabled when file system is NTFS): go to the sector of parent directory record where the current selected item stays.

e. Directory entry (enabled when file system is FAT): go to the sector of directory entry where the current selected item stays.
f. Beginning sector of parent directory (enabled when file system is FAT): go to the beginning sector of parent directory where the current selected item stays.

**Context menu of sector edit area**

This menu is shown in the following picture:

```
<table>
<thead>
<tr>
<th>Offset</th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>06CCDCE450</td>
<td>02</td>
<td>3D</td>
<td>FE</td>
<td>97</td>
<td>0F</td>
<td>DE</td>
<td>04</td>
<td>D1</td>
<td>01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE450</td>
<td>44</td>
<td>F9</td>
<td>04</td>
<td>03</td>
<td>FF</td>
<td>28</td>
<td>06</td>
<td>D1</td>
<td>01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE470</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE480</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE490</td>
<td>05</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE4A0</td>
<td>02</td>
<td>3D</td>
<td>FE</td>
<td>97</td>
<td>0F</td>
<td>DE</td>
<td>04</td>
<td>D1</td>
<td>01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE4B0</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE4C0</td>
<td>08</td>
<td>00</td>
<td>50</td>
<td>00</td>
<td>00</td>
<td>65</td>
<td>00</td>
<td>72</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE4D0</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE4E0</td>
<td>00</td>
<td>00</td>
<td>34</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE4F0</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE500</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE510</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE520</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE530</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE540</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE550</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE560</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE570</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06CCDCE580</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td>00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**a. Data selection**

1). Beginning of block: when selecting data, take the current cursor as the beginning block.

2). End of block: when selecting data, take the current cursor as end block.

3). Select all: select all blocks.

4). Clear block: unselect all blocks.
b. Copy and write

The menu for copy block is in the picture below:

1). Text: copy blocks as text.

2). Into as new file: save selected data area as a new file.

3). Hex values: copy selected area as hex values.

4). Editor display: copy sectors to a text file keeping the style in sector editor.

The menu for write block is in the following picture:
c. Go to offset and fill block

1). Go to byte offset: go to the area of specified byte by bit, as below:
2). Go to sector offset: go to the area of specified sector by bit, as below:
3). Fill block: wipe selected area

**Shortcuts in status bar**

Click the status bar in the bottom of the interface to perform corresponding operations:

- Sector: click this area to go to sector and right-click to copy current sector number or sector count.
b. Offset: click this area to go to offset and right click to copy current offset in hex or decimal.

c. Interpretation mode: signed and unsigned.
File Operation

Browse Files

DiskGenius can browse any files of partition which isn't restricted by operating system. Normally, operating system hides many files with the purpose of protecting important files and maintaining system's stable operation. When displaying files DiskGenius, adopts a way of analyzing file system type and reading and writing disk sectors directly, which is totally unrestricted by operating system. Therefore, DiskGenius can show all the files of the partition.
DiskGenius shows files in a way which is similar to Windows Explorer, displaying folder's hierarchical structure on the left and detailed file list on the right. By default, the right part shows partition parameters. If you click a folder on the left, then the right part will switch to its file list; also, you can realize the switch by clicking "Files" on the right panel, as follows:

![File List Example](image)

File properties shown by DiskGenius include icon, name, size, file type, properties shown by letters, short file names, modify time and create time. Files with properties like hidden, system, compressed and encrypted are in different colors to distinguish with each other. The meaning of letters in "File Attributes" is shown in the following picture:

![File Attributes Example](image)
Select and right-click a file and you can see a menu which can preview file, copy file to a different location, delete files, etc.
Copy Files From Partition

**Step 1.** Files and folders displayed in DiskGenius can be saved and copied to a specified location. Select data you want to copy and right-click it to choose "Copy To".

**Step 2.** Select a location to save data and DiskGenius starts to copy data.
Write Files To Partition

DiskGenius is able to write files to NTFS, exFAT, FAT32, FAT16, FAT12, Ext2, Ext3 and Ext4 partitions without considering whether the partition is hidden and whether it has a drive letter. The operation is compulsory and it may not fit operating system or software using the partition, thus this operation is kind of risky. Please be cautious when carrying out this operation.

To facilitate operation, DiskGenius provides several ways of copying files to partition. Before copying data please find out the target folder in the target partition.

Method 1: Write data to partition via context menu
Step 1. Select the partition to which you want to write data, click Files tab, and right-click the file list area to choose "Copy Files To Current Partition", as below:

Step 2. Select files you want to copy to this partition and click Open.

This method cannot copy folders. To copy a folder and its files, please refer to the following method.

Method 2: Drag files

After selecting a target partition and folder, please select files (or folders) in Windows Explorer. Then drag files (or folders) by mouse's left button to the target folder in DiskGenius' "Partition and Folder Tree" or "File List" window.
DiskGenius shows the following message. Click "Yes" button to start the copying process.

![Dialog Box](image)

### Method 3: Operating by shortcut keys

First select files (or folders) in Windows Explorer and then press keys "Ctrl_C"; then go back to DiskGenius, find out and select target partition and folder and press keys "Ctrl_V" DiskGenius will show the same dialog box as above; click "Yes" and it starts to copy files.

### Delete Files Directly

This feature is designed to forcefully delete files and folders that cannot be deleted by Windows in normal way. It skips file system driver and deletes files via writing disk directly, thus it is able to delete files on any partition except system partition.

**Step 1.** Select and right-click files or folders you want to delete and select "Delete Files Directly", as below:
Step 2: Click "Delete" button to give confirmation.

Note: DiskGenius deletes files directly from disk regardless the file access mechanism of operating system. Improper deletion may cause application error or system crash.
Delete Files Permanently

When you delete a file in Windows, it goes to Recycle Bin which allows you to restore deleted files in case that you change mind. If you empty Recycle Bin or delete files using Shift + Delete key combination, you can still get them back easily with the help of data recovery software. How to delete files permanently from storage device?

DiskGenius enables you to delete files permanently so that nobody can recover them by whatever means. It deletes and overwrites both the entry and data itself, thus deleted files are no longer recoverable.

**Step 1.** Select files you want to delete permanently and right click to choose "Delete Files Permanently".
Step 2. Select characters to overwrite data and click "Permanently Delete" button.

Step 3. Click "Delete" button and DiskGenius continue to delete files.
Create Folder

DiskGenius has full access to partitions formatted in NTFS, FAT32, exFAT, FAT12, FAT16, EXT2, EXT3 and EXT4 file system. It is able to read and write data on these partitions, such as create folders. You can follow steps below to create folders:

**Step 1.** Select a file path where you want to create a folder in the file list and right-click to select "New Folder":

![DiskGenius interface showing file list and context menu]

**Step 2.** Enter a folder name and click "Ok" button.
DiskGenius locks the partition where it is creating new folder. To prevent data loss, please exit all programs and close all files of the partition before creating a new folder. After the folder is created, the partition can be used normally.

**Preview Files**

File preview is available either during or after scanning, and DiskGenius supports to preview text files, pictures, Microsoft Office documents, videos, audios, etc., so that users can make sure whether lost files can be recovered correctly in advance.

**Step 1.** Select a file listed under "Files" tab, and you can view the thumbnail of the file.
Step 2. Double click the file to open the file preview dialog which shows the file content.
Others

Create WinPE Bootable USB Drive of DiskGenius

DiskGenius supports to make bootable USB disk based on Windows PE so that you can recover lost data, manage disk or backup data without booting system.

**Step 1** Insert a USB drive and launch DiskGenius. Click "Tools" menu and choose "Create WinPE Bootable USB Drive of DiskGenius" option.
Step 2. Click **OK** button from the pop-up window. Wait for a couple of seconds and the bootable disk will be created.
Step 3. Click OK button after the bootable disk is created successfully.

Note:

This function requires the USB disk be formatted to file system exFAT, FAT32 or NTFS, and it should have at least 800MB free space.

This function won't format the USB disk or damage files on the USB drive.
If you want to boot UEFI-based computer from the bootable disk, please format it to FAT32 before making bootable disk, otherwise the application cannot be launched.

**Reboot to DiskGenius WinPE Version**

Some functions related to system partition cannot be completed when operating system is running. In this case, you can boot to DiskGenius WinPE version.

**Step 1.** Click "File" menu and choose "Reboot To DiskGenius WinPE Version", as follows:
It may take several minutes to create Windows PE environment for the software.

![Creating Windows PE](image)

It takes about several minutes, please wait...

**Step 2.** Click **OK** button and computer will restart to boot to DiskGenius WinPE version.

![DiskGenius](image)

The computer will restart now. Please close all other applications and save the data before pressing the "OK" button.

**Reboot and Run DiskGenius DOS Version**

Some functions are not available in Windows system, and they can be carried out in DOS system. DiskGenius provides a function that even in Windows you can boot to its DOS version without using boot CD, bootable USB Flash Disk or installing DOS on the hard drive. Disk partitions displayed by DiskGenius in DOS version are the same as they are in Windows version. When you restart the computer, it boots to the current Windows system.

**Step 1.** To boot to DiskGenius DOS version, click "**File**" → "**Reboot to DiskGenius DOS Version**".
Step 2. Close all other applications and save data and click **OK** button.

**Note:**

The master boot record of the disk will be modified temporarily. If it is stopped by security software, please select "Allow".
If your computer cannot boot to DOS system or cannot boot to current system, please press and hold the "ALT" key during booting. After system is booted, do "rebuild MBR" command on the startup disk.

When you finish operations in the DOS version, you can turn off or restart the computer; the computer will boot to Windows system automatically.

Register DiskGenius

This article includes step-by-step methods to register DiskGenius. You can register the software either online or offline easily after getting the license code.

If you do not have a license code, you can buy one from here: Buy DiskGenius

1. Activate DiskGenius Online

Step 1. Click "Help" and select "Register" option as follows:
Enter your License Code, License Name and License Email, and click "Online Register" button.

It is recommended to Copy & Paste license code instead of entering all characters manually, as license code is space and case sensitive.
2. Activate DiskGenius Offline

If Internet connection is not available on the computer where DiskGenius is installed, you can still register it via offline activation.

**Step 1.** Enter your license information and click **"Offline Register"** button.

![Register DiskGenius window](image)

**Step 2.** Click **"OK"** button on the popped-up message box which prompts DiskGenius will generate three files.

![DiskGenius offline registration message](image)

Choose a location to save these files. Tip: You can save offline registration files to a removable disk such as USB flash drive.
Offline registration files are saved to the specified location.

**Step 3.** Copy all three of them to another computer which has access to the Internet. Then double-click the "OfflineReg" file and click "Register Now" button.
Step 4: Copy the new `Options.ini` file to back to the computer that cannot connect the Internet and click "Load Registration File" button.
Select the Options.ini file and click "Open" button. Then the software will be registered successfully.

If you've closed DiskGenius, you can simply copy the "Options.ini" file to the folder where DiskGenius is installed and replace the existing one.

3. Activate DiskGenius via Web Browser

This registration method is designed to register DiskGenius via a web browser when you are unable to register it online, but the computer does have an Internet connection.

**Step 1** Click "Help" and select "Register" option as follows:
Step 2. Enter your License Code, License Name and License Email, and click "Register Via Browser" button.
Step 3. Click "OK" button, and the webpage will open automatically. Note: do not close the registration dialog box of DiskGenius.

Step 4. On the webpage, you can see following information. Click "Copy" button to copy license information.

Step 5. Go back to DiskGenius, paste the license information to the registration box and click "OK". Then the software will be registered successfully.
Technical Support

If you have any question or need any help about DiskGenius, you can visit our support center for troubleshooting and more user guiders:

https://www.diskgenius.com/support.php

Besides, you can contact DiskGenius technical support team directly via email:

support@eassos.com